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Overview

Product description

TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate (Cat. No. A41237) is an efficient, easy-to-use
fixed-content OpenArray™ plate for the characterization of key respiratory tract microbial targets. The
plate includes TagMan™ assays that have been optimized for detection of respiratory tract viral and
bacterial nucleic acid. The plate also includes control assays for TrueMark™ Universal Extraction Control
Organism (B. atrophaeus), TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno) Control, and
the human RNase P RPPH1 gene. For a complete list of assays included in the plate, see “TagMan™
assays included in the plate” on page 7.

Additional TagMan™ assays for respiratory tract microbiota profiling experiments are available as
custom TrueMark™ OpenArray™ Plates. The assays perform well with total nucleic acid that is isolated
from nasopharyngeal swab, nasopharyngeal aspirate, and bronchoalveolar lavage (BAL) research
samples using the MagMAX™ Viral/Pathogen Ultra Nucleic Acid Isolation Kit.

TagMan™ assay designs and assay target sequences have undergone rigorous bioinformatics selection
and analysis to maximize strain coverage and minimize potential for off-target cross-reactivity. Qualified
TagMan™ assays have undergone performance testing to verify that results are accurate with high levels
of sensitivity and specificity.

TrueMark™ OpenArray™ Plate products and formats

TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate

The TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate (Cat. No. A41237) contains pre-plated,
dried down TagMan™ assays for respiratory tract microbiota profiling. For the complete lists of assays
included with the plate, see “TagMan™ assays included in the plate” on page 7.

Contents and storage
Table 1 TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate (Cat. No. A41237)

Component Amount | Array format Storage

TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate 1 plate 112 -25°C to -15°C

Assays for the 33 microbial targets and the TrueMark™ Universal RNA Spike In/Reverse Transcription
(Xeno) Control are plated in triplicate. Assays to the TrueMark™ Universal Extraction Control Organism
(B. atrophaeus) and human RNase P RPPH1 gene control are plated in duplicate. Each TrueMark™
OpenArray™ Respiratory Tract Microbiota Plate can be used to run 23 samples and one control sample.
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TagMan™ assays included in the plate
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The following TagMan™ assays are included in the TrueMark™ OpenArray™ Respiratory Tract Microbiota

Plate.

The assays can also be ordered in a Custom TrueMark™ OpenArray™ Plate.

Table 2 Assays for respiratory tract microbiota

Target organism Assay name Nucleic acid type Assay ID
Bacteria
Bordetella bronchiseptica / parapertussis / pertussis Bordetella DNA Ba06439624_s1
Bordetella pertussis B.pertussis DNA Ba06439623_s1
Chlamydophila pneumoniae C.pneumoniae DNA Ba06439616_s1
Haemophilus influenzae H.influenzae DNA Ba06439625 si
Klebsiella pneumoniae K. pneumoniae DNA Ba04932083_s1
Legionella pneumophila L.pneumophila DNA Ba06439617_s1
Mycoplasma pneumoniae M.pneumoniae DNA Ba06439620_s1
Staphylococcus aureus S.aureus DNA Ba04646259_s1
Streptococcus pneumoniae S.pneumoniae DNA Ba06439619_s1
Virus
Adenovirus AdV_1of2 DNA Vi99990001_po
Adenovirus AdV_20f2 DNA Vi99990002_po
Human Bocavirus HBoV DNA Vi99990003_po
Human Coronavirus 229E CoV_229E RNA Vi06439671_s1
Human Coronavirus HKU1 CoV_HKU1 RNA Vi06439674_s1
Human Coronavirus NL63 CoV_NL63 RNA Vi06439673_s1
Human Coronavirus OC43 CoV_0C43 RNA Vi06439646_s1
Human Enterovirus (pan assay) EV_pan RNA Vi06439631_s1
Human Enterovirus D68 EV_D68 RNA Vi06439669_s1
Human Metapneumovirus (hMPV) hMPV RNA Vi99990004_po
Human Parainfluenza virus 1 hPIV1 RNA Vi06439642_s1
Human Parainfluenza virus 2 hPIV2 RNA Vi06439672_s1
Human Parainfluenza virus 3 hPIV3 RNA Vi06439670_s1
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Table 2 Assays for respiratory tract microbiota (continued)

Target organism Assay name Nucleic acid type Assay ID
Human Parainfluenza virus 4 hPIV4 RNA Vi99990005_po
Human Respiratory Syncytial Virus A (RSVA) RSVA RNA Vi99990014_po
Human Respiratory Syncytial Virus B (RSVB) RSVB RNA Vi99990015_po
Human Rhinovirus 1/2 RV_1of2 RNA Vi99990016_po
Human Rhinovirus 2/2 RV_20f2 RNA Vi99990017_po
Human herpesvirus 3 (HHV3 — Varicella zoster Virus) HHV3 DNA Vi06439647_s1
Human herpesvirus 4 (HHV4 — Epstein-Barr Virus) HHV4 DNA Vi06439675_s1
Human herpesvirus 5 (HHV5 — Cytomegalovirus) HHVS DNA Vi06439643_s1
Human herpesvirus 6 (HHV6) HHV6 DNA Vi06439627_s1
Influenza A Flu_A_pan RNA Vi99990011_po
Influenza A/H1-2009 Flu_A_H1 RNA Vi99990009_po
Influenza A/H3 Flu_A_H3 RNA Vi99990010_po
Influenza B Flu_B_pan RNA Vi99990012_po
Table 3 Assays for respiratory tract microbiota controls
Control name Assay name | Nucleic acid type Assay ID
;I'BrL.lexsﬁr)I;‘;elir;i)versal Extraction Control Organism B.atrophaeus DNA Ba06596576_s1
;I;Lejilc\)/;aélg;tl:;}iversal RNA Spike In/Reverse Transcription Xeno RNA Ac00010014_a
Human RNase P RPPH1 gene RPPHA1 DNA Hs04930436_g1
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TrueMark™ OpenArray™ Plate products and formats

Additional TagMan™ assays for respiratory tract microbiota profiling, available in

custom plate formats

The following TagMan™ assays are not included in the TrueMark™ OpenArray™ Respiratory Tract
Microbiota Plate. For respiratory tract microbiota profiling using these assays, use a Custom TrueMark™

OpenArray™ Plate.

Target organism Assay name | Nucleic acid type Assay ID
Bacteria
Bordetella holmesii B.holmesii DNA Ba06439621_s1
Coxiella burnetii C.burnetii DNA Ba06439618_s1
Moraxella catarrhalis M.catarrhalis DNA Ba06439622_s1
Fungus
Pneumocystis jirovecii P.jirovecii DNA Fn06439626_s1
Virus
Human Parechovirus HPeV RNA Vi99990006_po
Measles virus Measles RNA Vi99990013_po
Middle East Respiratory Syndrome coronavirus (MERS) MERS_CoV RNA Vi06439644_s1
Mumps virus Mumps RNA Vi06439657_s1
Severe Acute Respiratory Syndrome coronavirus (SARS) SARS_CoV RNA Vi06439634_s1

Custom TrueMark™ OpenArray™ Plates for respiratory tract microbiota

profiling experiments

Custom TrueMark™ OpenArray™ Plate contain pre-plated, dried down TagMan™ assays for respiratory

tract microbiota profiling.

Array format Number of assays

Maximum number of samples

56 56 48
112 112 24
168 168 16

Note: We recommend at least three technical replicates of each reaction.

Configure and order Custom TrueMark™ OpenArray™ Plates

1. Go to thermofisher.com/order/custom-array.

2. For array type, select TrueMark™ OpenArray™ Real-Time PCR Inventoried Assays Format.
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3. (Opti

onal) In the table, click View Layout to preview the layout of the plate.

4. Inthe table, click Select to configure a plate with the desired array format.
The Custom Array Configurator screen displays.

Custom Array Configurator

Q Search For Assays 2 Import Your Assay List —@ @— Complete Your Design >
Array Unique
Array name” —@ 1D Array type Format Targets Filled Invalid Empty
TagMan® OpenArray® Real-Time PCR Inventoried 18 0 n n n
Assays Format o
Select Edit Move Export Help Save Your Array
Click to select assays | Click & drag to move assays | Ctrl+C to copy an assay | Cirl+V to paste an assay
1 2 3 4 5 8 7 g (l)
Display Assay Target v
s Sub Array Al
al
a2 Filled 0
3 .
# Invalid 0
a4
Empty

(@ Array name

@1

mport Your Assay List

(3 save Your Array
@ Complete Your Design

5. Ente

r the custom array name in the Array name text field.

6. Click Import Your Assay List, then upload or copy-paste the assay information:

Under Upload a list of Assay IDs, click Choose File, then select a tab-delimited text file (TXT)
containing Assay IDs.
or

Under Enter a list of Assay IDs, paste the Assay IDs, then click Import Entered List.

7. Follow the on-screen instructions to configure the assays on the plate.

8. (Optional) Click Save Your Array at any time to save the array configuration to your Thermo Fisher

Scie

ntific account.

9. When the plate is configured, click Complete Your Design, then follow the on-screen instructions
to complete the order.
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Materials required but not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Materials required for nucleic acid isolation

Nucleic acid isolation kit
Table 4 MagMAX™ Viral/Pathogen Ultra Nucleic Acid Isolation Kit (Cat. No. A42356)

Component Amount Storage
Binding Solution 60 mL
Wash Solution 100 mL
Elution Solution 10 mL 15-25°C
Nucleic Acid Binding Beads 2mL
Proteinase K 1mL
Enzyme Mix 5mL —25°C to -15°C

Additional materials

Item Source

Instrument and equipment

KingFisher™ Flex Magnetic Particle Processor 96DW with deep-well heat block 5400630
Adjustable micropipettors MLS
Multi-channel micropipettors MLS
Plastics and consumables

KingFisher™ 96 Deep-Well Plate 95040450
KingFisher™ 96 KF microplate (200 pL) 97002540
KingFisher™ 96 tip comb for DW magnets 97002534
Conical Tubes (15 mL) AM12500
Conical Tubes (50 mL) AM12501
Nonstick, RNase-free Microfuge Tubes, 1.5 mL AM12450
Nonstick, RNase-Free Microfuge Tubes, 2.0 mL AM12475
MicroAmp™ Clear Adhesive Film 4306311
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(continued)
Item Source

Filtered micropipettor tips MLS

Reagent reservoirs MLS

Reagents

Ethanol, 100% (molecular biology grade) MLS
Nuclease-free water AM9932, or equivalent
Universal Transport Media, for preparation of negative extraction control Fisher Scientific 22-031-14,

or equivalent
(Optional) 1X PBS (1X), pH 7.4, for reconstitution of TrueMark™ Universal
. . 10010023

Extraction Control Organism (B. atrophaeus)

Materials required for preamplification

ltem Source

Instrument and equipment

Thermal cycler, one of the following (or equivalent):
* Veriti™ Thermal Cycler, 96-well standard block _
*  SimpliAmp™ Thermal Cycler Contact your local sales office

* ProFlex™ PCR System

Microcentrifuge MLS
Vortex mixer MLS
Micropipettes MLS

Tubes, plates, and other consumables

MicroAmp™ Optical 96-Well Reaction Plate N8010560, or equivalent; see thermofisher.com/

plastics
MicroAmp™ Clear Adhesive Film 4306311
Aerosol-resistant barrier pipette tips MLS
Disposable gloves MLS
Reagents
Genomic DNA/RNA See page 17
Megaplex™ Preamp Primers, RTM A41374

12 TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments User Guide


https://www.thermofisher.com/order/catalog/product/AM9932
https://www.fishersci.com/us/en/catalog/search/products?keyword=22-031-14
https://www.thermofisher.com/order/catalog/product/10010023
https://www.thermofisher.com/order/catalog/product/N8010560
http://www.thermofisher.com/plastics
http://www.thermofisher.com/plastics
https://www.thermofisher.com/order/catalog/product/4306311
https://www.thermofisher.com/order/catalog/product/A41374

Chapter 1 Overview

Materials required but not supplied

o5
hh S

(continued)

Iltem Source
TagPath™ 1-Step RT-gPCR Master Mix, CG A15299
Nuclease-free water AM9937, or equivalent

Materials required for the OpenArray™ Plate workflow

Item Source
Instruments, software, and equipment
OpenArray™ Sample Tracker Software Ny
(Not required for OpenArray™ AccuFill™ Software v2.0)
QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945
QuantStudio™ 12K Flex Real-Time PCR Instrument with OpenArray™ block 4471090
(QuantStudio™ 12K Flex OpenArray™ AccuFill™ System)
Centrifuge, capable of spinning sample plates at 1,000 x g MLS
Plates and accessories
OpenArray™ 384-well Sample Plates, black 4482221

(Optional)
Biomek™ Seal and Sample Foil Lids

Beckman Coulter™

OpenArray™ Plates with TagMan™ Assays

(for pre-plating step) 538619

OpenArray™ AccuFill™ System Tips 4458107

QuantStudio™ 12K Flex OpenArray™ Accessories Kitl?] 4469576

Forceps MLS

Reagents

Preamplified genomic DNA/RNA See page 21
* A41237

Custom orderedts

TagMan™ OpenArray™ Real-Time PCR Master Mix

4462164

Ethanol

MLS

' Included with the QuantStudio™ 12K Flex Software.

[l Each kit contains the items needed to assemble up to 10 plates: 12 lids and plugs, 12 immersion fluid syringes, and 2 carriers. Each

custom OpenArray™ Plate order is shipped with accessories kits.

Bl See “Custom TrueMark™ OpenArray™ Plates for respiratory tract microbiota profiling experiments” on page 9.

TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments User Guide

13


https://www.thermofisher.com/order/catalog/product/A15299
https://www.thermofisher.com/order/catalog/product/AM9937
https://www.thermofisher.com/order/catalog/product/A24945
https://www.thermofisher.com/order/catalog/product/4471090
https://www.thermofisher.com/order/catalog/product/4482221
https://www.thermofisher.com/order/catalog/product/4458107
https://www.thermofisher.com/order/catalog/product/4469576
https://www.thermofisher.com/order/catalog/product/A41237
https://www.thermofisher.com/order/catalog/product/4462164

Ff;!‘,fﬁ Chapter 1 Overview
Optional controls

Materials required for data analysis

ltem Source

Software, select one of the following:

Relative Quantification Application E (recommended) apps.thermofisher.com

QuantStudio™ 12K Flex Software Included with QuantStudio™ 12K Flex Real-Time

PCR System
Optional controls

Control Purpose How to use Cat. No.
TrueMark™ Universal Synthetic RNA control for Nucleic acid isolation: Add
RNA Spike In/Reverse RNA recovery, reverse to samples along with the A39179
Transcription (Xeno) transcription, preamplification, | Binding/Bead Mix
Control and PCR
TrueMark™ Universal Lyophilized organism control | Nucleic acid isolation: Stand-alone
Extraction Control for nucleic acid extraction and | sample, or add to samples after A39180
Organism (B. atrophaeus) | purification Enzyme Mix
TrueMark™ Respiratory DNA plasmid control for real- | Real-time PCR: Stand-alone sample
Tract Microbiota time PCR added directly to the plate A39178
Ampilification Control

TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno) Control

TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno) Control is a synthetic RNA control
that serves as an exogenous process control for nucleic acid isolation and RNA recovery, reverse
transcription, preamplification, and PCR. The control is used with the proprietary TagMan™ assay for
Xeno™ sequences, which is included in the TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate.

TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno) Control is supplied at a concentration
of 10,000 copies/pL. During nucleic acid isolation, 10 pyL of the control can be added to each test
sample along with the nucleic acid binding reagents (Binding Solution). When carried through the
respiratory tract microbiota workflow, the control is used to monitor nucleic acid recovery, RNA reverse
transcription, cDNA preamplification, and PCR. The control can be used to identify sample-specific
amplification inhibition, which reduces the likelihood of false negatives and provides confidence that
results are accurate. It is recommended that the control is added to each sample during nucleic acid
isolation.
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TrueMark™ Universal Extraction Control Organism (B. atrophaeus)

TrueMark™ Universal Extraction Control Organism (B. atrophaeus), serves as a process control for cell
lysis and nucleic acid recovery. The control is used with the proprietary TagMan™ assay for Bacillus
atrophaeus sequences.

Like other gram-positive bacteria, Bacillus atrophaeus has thick cell walls than can be difficult to lyse.
This characteristic makes gram-positive bacteria an ideal control to monitor the efficiency of cell lysis
and subsequent nucleic acid recovery.

TrueMark™ Universal Extraction Control Organism (B. atrophaeus) is supplied lyophilized with a quantity
of 1 x 10 copies/vial, and is reconstituted in 200 pL of 1X PBS (1X), pH 7.4 to a final concentration

5 x 10° copies/pL. During nucleic acid isolation, 10 pL of the control is processed as a stand-alone
sample in a background of universal transport media. It can be added to the negative extraction control,
and may also be added to one or more test samples at the start of the extraction process. The control
is carried through the remainder of the workflow with the test samples. It is recommended that at least
one stand-alone control sample is run per extraction plate.

TrueMark™ Respiratory Tract Microbiota Amplification Control

TrueMark™ Respiratory Tract Microbiota Amplification Control contains a linearized multi-target plasmid
with target sequences for each available respiratory tract microbiota profiling assay. The plasmid also
contains target sequences for the TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno)
Control, the TrueMark™ Universal Extraction Control Organism (B. atrophaeus), and the human RNase P
RPPH1 gene. It can be included in respiratory tract microbiota profiling experiments as a positive
control for panel-specific amplification.

TrueMark™ Respiratory Tract Microbiota Amplification Control is supplied at a concentration of

1 x 105 copies/pL. During real-time PCR, 2.5 pL of the control is used as a stand-alone sample in

2 wells of the TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate. The control can be used if
needed to verify assay performance and to help with troubleshooting.

Note: The amplification control RV target sequence is a perfect match to the RV_10f2 assay target, and
contains a mismatch with the RV_20f2 assay target. Lower Amp Scores and Cq confidence scores can
be noted for RV_20f2 versus RV_10f2.
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Workflow

Respiratory tract microbiota profiling experiments

Isolate nucleic acid using MagMAX™ Viral/Pathogen Ultra Nucleic
Acid Isolation Kit (page 17)

Start with bronchoalveolar lavage, nasopharyngeal swab, or nasopharyngeal aspirate samples

. Perform preampilification (page 21)

Prepare the OpenArray™ Plates with OpenArray™ AccuFill™ Software
v1.2 (page 24) OR Prepare the OpenArray™ Plates with OpenArray™
AccuFill™ Software v2.0 (page 32)

Seal and run the OpenArray™ Plates (page 41)

Analyze data (page 46)
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Isolate nucleic acid using MagMAX™
Viral/Pathogen Ultra Nucleic Acid
Isolation Kit

For required materials, see “Materials required for nucleic acid isolation” on page 11.

Procedural guidelines

* Perform all steps at room temperature (20-25°C) unless otherwise noted.

¢ Ensure that Nucleic Acid Binding Beads remain in a homogeneous suspension while pipetting.
Vortex beads before use.

Before first use of the kit

¢ Download the KingFisher™ Flex script MVP_Ultra_Flex from the MagMAX™ Viral/Pathogen Ultra
Nucleic Acid Isolation Kit (Cat. No. A42356) product page, then install it on the instrument.

See the instrument user guide for instructions to install the script.

* Prepare fresh 80% Ethanol using 100% absolute Ethanol and Nuclease-free water, sufficient for
1.5 mL per sample, plus 10% overage.

Set up the KingFisher™ Flex instrument

¢ Ensure that the KingFisher™ Flex instrument has the appropriate magnetic head and heat block
installed.

— 96 deep-well magnetic head
— 96 deep-well heat block

* Ensure that the MVP_Ultra_Flex script is installed on the instrument.
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Reconstitute TrueMark™ Universal Extraction Control Organism (B. atrophaeus)

Reconstitute TrueMark™ Universal Extraction Control
Organism (B. atrophaeus)

Use of the TrueMark™ Universal Extraction Control Organism (B. atrophaeus) is optional.
1. Remove metal fastener from vial using tweezers and place vial on ice.
2. Remove rubber stopper from vial, then add 200 pL 1X PBS (1X), pH 7.4 to the vial.
3. Replace the rubber stopper, then vortex the tube to mix.

4. Transfer reconstituted sample to a 1.5-ml tube, then store on ice or at 4°C.

Note: Store the reconstituted control at 4°C for up to 48 hours. For long term storage, store the
reconstituted control at -80°C to —20°C for up to 4 months. Mix well to resuspend before use.

The final concentration of the control is 5 x 108 copies/pL.

Set up the processing plates

Set up the processing plates outside the instrument according to the following table. Cover the plates
with a temporary seal, then store at room temperature for up to 1 hour while you set up Sample Plate.

Plate type Plate position Plate ID Reagent Volume per well

2 Wash 1 Plate Wash Solution 1000 pL

3 Wash 2 Plate 80% Ethanol 1000 pL
Deep wellll]

4 Wash 3 Plate 80% Ethanol 500 pL

5 Elution Plate Elution Solution 60 pLi2
Standardl! 6 Tip Comb 96DW Tip Comb -

' KingFisher™ 96 Deep-Well Plate
' The elution volume can be increased to a maximum of 100 L.
Bl KingFisher™ 96 KF microplate

Set up Sample Plate, then start processing

(Optional) Reconstitute TrueMark™ Universal Extraction Control Organism (B. atrophaeus) before use in
step 3 (see page 18).

1. Swirl the bottle of Enzyme Mix, then place on ice.

2. Add 50 pL of Enzyme Mix to each well in a KingFisher™ 96 Deep-Well Plate (Sample Plate).
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[0
Continue processing to bind, wash, and elute the nucleic acid

3. Add samples and controls to the appropriate well containing Enzyme Mix.

Sample or control Instructions

Sample Add 200-400 pL of sample to a well.

Negative Extraction Control

(NEC) Add 200-400 pL of Universal Transport Media to a well.

* Combine 10 pL of reconstituted control with 390 pL of

(Optional) TrueMark™ Universal Universal Transport Media in a well.

Extraction Control Organism or
(B. atrophaeus) * Add 10 pL of reconstituted control to one or more sample
wells.

4. On the KingFisher™ Flex instrument, select the MVP_Ultra_Flex script, then press Start.
5. Follow the instrument prompts to load sample and processing plates, then press Start.

Proceed immediately to the next step.

Continue processing to bind, wash, and elute the nucleic
acid

1. During the enzyme treatment incubation on the instrument, prepare the Binding/Bead Mix.
a. Vortex the tube of Nucleic Acid Binding Beads to fully resuspend the beads.

b. Combine the following components for the required number of samples, plus 10% overage.

IMPORTANT! Binding Solution is viscous. Pipet slowly to avoid bubbles and to ensure that
the correct volume is delivered.

Component Volume per sample
Binding Solution 530 uL
Nucleic Acid Binding Beads 20 uL
(Optional) TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno)
10 pL
Control
Total 550 uL or 560 pL

2. Gently invert the Binding/Bead Mix 5 times to mix, then store at room temperature until the next
step.

3. When prompted by the instrument (approximately 20 minutes after the start of the script), remove
the Sample Plate from the instrument.
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Continue processing to bind, wash, and elute the nucleic acid

4. Add 10 pL of Proteinase K to each sample in the Sample Plate.

Note: Add the Proteinase K to the sample separately from and before the Binding/Bead Mix.
Combining the reagents, or adding in a different order can affect nucleic acid recovery.

5. Gently invert the Binding/Bead Mix 5 times to mix, then use a manual pipet (single or
multi-channel) to dispense the appropriate volume to each sample and control well in the
Sample Plate.

* 550 pL: Binding/Bead Mix only or

* 560 pL: Binding/Bead Mix + TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno)
Control

IMPORTANT! Binding/Bead Mix is viscous. Pipet slowly to avoid bubbles and to ensure that the
correct volume is delivered. Invert the Binding/Bead Mix regularly to avoid bead settling.

6. Return Sample Plate to the instrument, then press Start to resume the script.

7. When processing is complete (~30 minutes after adding Binding/Bead Mix), remove Elution Plate
from instrument.
The purified nucleic acid is in Elution Plate.

8. Transfer the nucleic acid samples to a 96-well storage plate or seal Elution Plate.

Store nucleic acid samples on ice for immediate use or at —20°C for longer-term storage.
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Perform preamplification

For required materials, see “Materials required for preamplification” on page 12.

Good laboratory practices for PCR and RT-PCR

* Wear clean gloves and a clean lab coat.

— Do not wear the same gloves and lab coat that you have previously used when handling
amplified products or preparing samples.

* Change gloves if you suspect that they are contaminated.

* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation and reaction setup.

- Amplification and analysis of products.
* Do not bring amplified products into the reaction setup area.
* Open and close all sample tubes carefully. Avoid splashing or spraying samples.
* Keep reactions and components capped as much as possible.
* Use a positive-displacement pipettor or aerosol-resistant barrier pipette tips.

® C(Clean lab benches and equipment periodically with 10% bleach solution or DNA decontamination
solution.

Perform preamplification

Note: Preamplification of the TrueMark™ Respiratory Tract Microbiota Amplification Control is not
recommended.

1. Prepare the PreAmp Reaction Mix: Combine the following components for the number of required
reactions plus 10% overage, then mix thoroughly by pipetting up and down.

Component Volume per reaction
TagPath™ 1-Step RT-gPCR Master Mix, CG 25puL
Megaplex™ Preamp Primers, RTMI1] 2.5 L

' Megaplex™ Preamp Primers, RTM contains primers for all of the respiratory tract microbiota assays, plus the TrueMark™
Universal RNA Spike In/Reverse Transcription (Xeno) Control and the RNase P RPPH1 gene. It does not contain primers for
the TrueMark™ Universal Extraction Control Organism (B. atrophaeus).
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Dilute the preamplified sample

2. Distribute the PreAmp Reaction Mix, then nuclease-free water or sample nucleic acid to the
appropriate wells of a 96-well plate.

Component Sample reaction No-template control (NTC) reaction
PreAmp Reaction Mix 5pL 5L
Sample DNA or NEC 5uL -
Nuclease-free water - 5L
Total volume per reaction 10 yL 10 yL

3. Seal the plate with adhesive film.

4. Gently vortex the plate for 10 seconds to mix, then briefly centrifuge to bring contents to the
bottom of the wells.

5. Place the plate in a thermal cycler that is programmed with the following thermal cycling
conditions, then start the run.

Stage Step Temperature Time
Hold UNG incubationl'! 25°C 2 minutes
Hold Reverse transcription 50°C 30 minutes
Hold Activation 95°C 2 minutes
Denaturation 95°C 15 seconds

Cycling (14 cycles)

Annealing/ Extension 60°C 2 minutes
Hold Inactivation 99.9°C 10 minutes

Hold — 4°C Hold

[ Heat-labile UNG is completely inactivated during the initial ramp to 95°C.

6. Store the plate on ice until dilution for PCR (see “Dilute the preamplified sample” on page 22).

Dilute the preamplified sample

To determine dilution volumes, first determine the total volume of diluted preamplified sample that is
required for PCR (see “Set up the PCR reactions in an OpenArray™ 384-well Sample Plate (OpenArray™
AccuFill™ Software v1.2)” on page 28 or “Set up the PCR reactions in an OpenArray™ 384-well Sample
Plate (OpenArray™ AccuFill™ Software v2.0)” on page 34). We recommend that you prepare only the
volume of diluted preamplified sample that is required for your experiment. The undiluted preamplified
sample can be stored at —20°C long term.

1. Vortex, then briefly centrifuge the plate that contains the completed preamplification sample
reactions.

2. Remove the adhesive film from the plate.
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Dilute the preamplified sample

3. Prepare a 1:10 dilution of the preamplified samples in a new 96-well plate.

a. Transfer the desired volume of the preamplified samples to a new 96-well plate (for example,
2 yb).

b. Add the appropriate volume of nuclease-free water to each sample and control well (for
example, 18 pL).

4. Seal the plate with new adhesive film.
5. Vortex the plate for 10 seconds, then briefly centrifuge.

6. Proceed directly to prepare the OpenArray™ Plates (see “Set up the PCR reactions in an
OpenArray™ 384-well Sample Plate (OpenArray™ AccuFill™ Software v1.2)” on page 28 or “Set
up the PCR reactions in an OpenArray™ 384-well Sample Plate (OpenArray™ AccuFill™ Software
v2.0)” on page 34).

Seal the plate that contains the unused portion of the undiluted preamplified samples, then store at
—20°C.
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Prepare the OpenArray™ Plates with

OpenArray™ AccuFill™ Software v1.2

For required materials, see “Materials required for the OpenArray™ Plate workflow” on page 13.

For instructions for OpenArray™ AccuFill™ Software v2.0, see Chapter 5, “Prepare the OpenArray™

Plates with OpenArray™ AccuFill™ Software v2.0”.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccufFill™ System User Guide 4456986
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Workflow

Workflow

Microbiota profiling experiments with OpenArray™ Plates

Generate 384-well sample plate layouts in the OpenArray™ Sample
Tracker Software (page 27)

Set up the PCR reactions in an OpenArray™ 384-well Sample Plate
(OpenArray™ AccuFill™ Software v1.2) (page 28)

Set up the OpenArray™ AccuFill™ Instrument and the OpenArray™
AccuFill™ Software (page 29)

Transfer reactions to the OpenArray™ Plate using the OpenArray™
AccuFill™ Instrument (page 30)

Seal the OpenArray™ Plate (page 41)

Run the OpenArray™ Plate on the QuantStudio™ 12K Flex Instrument
(page 44)

Check the quality-control images (page 45)

One-time procedures

Set up default folders and software preferences

This procedure simplifies the file locations used in the OpenArray™ AccuFill™ Software.

Set up the default file locations and preferences before using the QuantStudio™ 12K Flex OpenArray™
AccuFill™ System for the first time.

1. Create the following four folders in a convenient location on the same computer drive as the
OpenArray™ AccuFill™ Software:
® TPF Files
® Sample Tracker 96-well Input
® Sample Tracker 384-well CSV Files
® Loaded TPF Files
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One-time procedures

2. (Optional) Copy a template file into the OpenArray™ Sample Tracker Software folder.

¢ Navigate to this folder on your computer: <drive>:\Program Files (x86)\Applied
Biosystems\OpenArray Sample Tracker\examples.

®* Copythe 96-Well Sample Plate 1.csv template file, which is provided with the
OpenArray™ Sample Tracker Software.

* Paste the template file into the Sample Tracker 96-well Input folder.

3. In the OpenArray™ Sample Tracker Software, select View » Preferences, then enter the following

preferences:
Field Selection
Experiment Type Gene Expression
OpenArray™ Plate Select the OpenArray™ format that will be run most often, such as
Gene Expression — 112,
Pipettor Fixed or Adjustable tip spacing
Import Data Directory | Sample Tracker 96-well Input
Export Data Directory | Sample Tracker 384-well CSV Files

4. Inthe OpenArray™ AccuFill™ Software, select Instrument » Edit Preferences » Require Sample
Integration, then select the folders indicated in this table:

OpenArray™ AccuFill™ Software

Default folder Folder contents
folder
OpenArray Plate File TPF Files TPF files for the OpenArray™ Plates, with
Input Folder assay name and location
Sample Plate File Sample Tracker CSV 384-well sample plate layout files
Folder 384-well CSV
Files

Loaded OpenArray Plate |Loaded TPF Files |Integrated TPF files generated during
File Folder processing with the OpenArray™ AccuFill™
Software.

5. In the QuantStudio™ 12K Flex Software, select Tools » Preferences » OpenArray, then select the
Loaded TPF Files folder for the software Setup Folder.

Note: If the QuantStudio™ 12K Flex Software is not on the same computer as the OpenArray™
AccuFill™ Software, transfer the loaded TPF files to the computer running the QuantStudio™ 12K
Flex Software.

Obtain TPF files

Go to thermofisher.com/OA-platefiles to obtain the TPF files for the TrueMark™ OpenArray™
Respiratory Tract Microbiota Plate.

Set up the optimized folder locations and software preferences before downloading TPF files to your
computer. See “Set up default folders and software preferences” on page 25.
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Generate 384-well sample plate layouts in the OpenArray™ Sample Tracker Software

Generate 384-well sample plate layouts in the OpenArray™
Sample Tracker Software

Before generating 384-well sample plate layouts, see “One-time procedures” on page 25 to complete
the following tasks:

* Set up optimized folder locations and software preferences.
¢ Download the TPF files for the OpenArray™ Plates into the TPF Files folder.

1. Using a spreadsheet program, create a 96-well sample CSV file.

a. Navigate to the following folder, then open the 96-Well Sample Plate 1.csvtemplate
that is provided with the OpenArray™ Sample Tracker Software.

<drive>:\Program Files (x86)\Applied Biosystems\OpenArray Sample
Tracker\examples

b. Save As the template as a new 96-well sample CSV file. Save your 96-well sample CSV file in
the Sample Tracker 96-well Input folder.

c. Enter or copy the sample names into your 96-well sample CSYV file.
2. Open the OpenArray™ Sample Tracker Software.

3. In the Properties screen, select Gene Expression for Experiment Type, then select the
appropriate settings for OpenArray™ Plate and Pipettor.

4. Inthe Samples screen, click £ Import, then select and import your 96-well sample CSV file that
you created in step 1.

5. In the Sample Mapping screen, confirm that the samples for a single OpenArray™ Plate are
assigned to one color.

Note: If necessary, correct the OpenArray™ Plate and Pipettor settings in the Properties screen.

6. In the Sample Mapping screen, click the 384-Well Plate tab, then click Export » Export *.csv.

N

Select 384-Well Plate (for AccufFill), enter a file name, then save the exported file.

Plate layouts for the 384-well sample plates are saved to individual CSV files in the Sample Tracker
384-well CSV Files folder.
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Set up the PCR reactions in an OpenArray™ 384-well
Sample Plate (OpenArray™ AccuFill™ Software v1.2)

IMPORTANT! The 4 x 12 area(s) of the OpenArray™ 384-well Sample Plate being filled must match the
area(s) designated in the OpenArray™ Sample Tracker Software for that set of samples.

1. Remove an OpenArray™ Plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ Plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. Gently swirl the contents of the TagMan™ OpenArray™ Real-Time PCR Master Mix to thoroughly
mix. Do not invert the bottle.

3. Following the plate layout designated in the OpenArray™ Sample Tracker Software, add master
mix, then DNA samples, to the wells of an OpenArray™ 384-well Sample Plate.
(Optional) Use the TrueMark™ Respiratory Tract Microbiota Amplification Control in place of diluted
preamplified sample, as a positive amplification control sample.

Component Volume per well Volume per sample
TagMan™ OpenArray™ Real-Time PCR Master Mix 2.5uL 5.0 uL
Diluted preamplified sample 25 L 5.0uL
Total reaction volume 5.0 yL 10.0 pL

Note: An overage is recommended when preparing the components.

4. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function on a
multi-channel pipette.

5. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

6. Centrifuge the plate at 1,200 x g for 1 minute.

7. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.

If you make a sample layout error before the AccuFill™ procedure — Repeat “Generate 384-well sample
plate layouts in the OpenArray™ Sample Tracker Software” on page 27 with a corrected 96-well sample
CSV file.
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Set up the OpenArray™ AccuFill™ Instrument and the OpenArray™ AccuFill™ Software

Set up the OpenArray™ AccuFill™ Instrument and the
OpenArray™ AccuFill™ Software

IMPORTANT! Do not use OpenArray™ AccuFill™ System Tips that exceed the expiration date (shown
on the outer box that contains the tip trays).

1. In the OpenArray™ AccuFill™ Software, click Setup and Load.
The Setup Load Information window appears.

Setup Load Information

Loading information

Specify the type of load you want to perform. Enter Plate and OpenArray® Plate barcodes by
scanning them, typing them. or selecting the associated file

@— [¥] Use Sample Integration D Faorce Single Sample Loading
Sample Plate f @ Plate Holder Position 1
@ | Plats Holdsr Position 2 [Browse..|
Plate Holder Position 3 _@
Plate Holder Position 4 @

Select Samples to Load

Click the section on the sample plate from which the first sample will be extracted. The image on
the right shows how the sample will be applied to the OpenArray Plates_

Plate Holder Position 1

Plate Holder Position 2

late Holder Position 3

late Holder Position 4

TINTIN RO

EEEE
S

!

Cancel

@ Use Sample Integration checkbox; select to integrate TPF files and the 384-well sample plate CSV file.

@ Browse button; click to locate and select the 384-well sample plate CSV file. The button is displayed only if
Use Sample Integration is selected.

@ Browse buttons; click to locate and select the TPF files for the OpenArray™ Plates that will be placed in the
corresponding Plate Holder Position on the deck of the OpenArray™ AccuFill™ Instrument. The buttons are
displayed only if Use Sample Integration is selected.

@ Plate Holder Position corresponding to the position of the OpenArray™ Plate on the deck of the instrument.

2. Configure the Loading Information pane for sample integration using the 384-well sample plate
CSYV file and TPF files.

a. In the Loading Information pane (top section of the window), ensure that the Use Sample
Integration checkbox is selected.

b. Click Browse to the right of the Sample Plate field, then select the 384-well sample plate
CSV file that you generated with the OpenArray™ Sample Tracker Software in the Sample
Tracker 384-well CSV Files folder.

c. Click Browse to the right of the Plate Holder Position of the OpenArray™ Plate, then select
the TPF file for the OpenArray™ Plate in the TPF Files folder.

TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments User Guide 29



8  Chapter 4 Prepare the OpenArray™ Plates with OpenArray™ AccufFill™ Software v1.2
Transfer reactions to the OpenArray™ Plate using the OpenArray™ AccuFill™ Instrument

3. In the Select Samples to Load pane (bottom section of the window), click the corresponding
4 x 12 area of the 384-well sample plate image, then click Next.
The Setup Deck window is displayed.

4. In the OpenArray™ AccuFill™ Instrument, ensure that:
* Tip boxes and tips are loaded as shown in the Setup Deck window.
* The lids are removed from the tip boxes.
¢ The waste bin in the instrument is emptied.

5. In the Setup Deck window, confirm that the deck is ready:
* Select The tips are configured as shown above.
* Select The Waste Bin is empty.

Transfer reactions to the OpenArray™ Plate using the
OpenArray™ AccuFill™ Instrument

IMPORTANT! Ensure that the OpenArray™ Plate is thawed and that the entire plate is at room
temperature.

1. Prepare the items needed to seal the loaded OpenArray™ Plate (next section).

Note: The OpenArray™ Plate must be sealed promptly after being loaded with the reactions, as
described here.

* Ensure that the QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 is ready.

* Gather and remove from their packaging the following: an OpenArray™ Lid, plug, syringe with
OpenArray™ Immersion Fluid, and syringe tip.

* Attach the syringe tip to the syringe, carefully push some of the fluid through the tip to remove
air bubbles, then lay the syringe aside.

2. Load the OpenArray™ Plate and the OpenArray™ 384-well Sample Plate into the OpenArray™
AccuFill™ Instrument.

* OpenArray™ Plate —Remove the plate from its sleeve, then place the plate in the appropriate
plate holder position in the instrument.

Ensure that the barcode on the OpenArray™ Plate is facing left and the serial number is facing
right.

* OpenArray™ 384-well Sample Plate —Place the 384-well sample plate onto the deck of the
instrument, then use forceps to peel the foil from the filled area of the plate.

3. Close the door of the instrument.

4. In the OpenArray™ AccuFill™ Software Setup Deck window, select the following confirmations:
* The OpenArray Plate is in the Plate Holder
* Remove foil from the highlighted section of the Sample Plate
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A
Transfer reactions to the OpenArray™ Plate using the OpenArray™ AccuFill™ Instrument

5. Click Load.

6. As soon as the Remove OpenArray Plate window appears, open the instrument door and remove
the loaded OpenArray™ Plate.

7. Proceed immediately to seal the OpenArray™ Plate.
See “Seal the OpenArray™ Plate” on page 41.

Note: For best results, seal the OpenArray™ Plate within 90 seconds of completion of loading to
prevent evaporation.
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Prepare the OpenArray™ Plates with
OpenArray™ AccuFill™ Software v2.0

For required materials, see “Materials required for the OpenArray™ Plate workflow” on page 13.

For instructions for OpenArray™ AccuFill™ Software v1.2, see Chapter 4, “Prepare the OpenArray™
Plates with OpenArray™ AccuFill™ Software v1.2”.

This chapter describes the full run workflow. For other workflow options, see the following
documentation.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide MANO0025669
ggfzrr):r:?ey"“ AccufFill™ Software v2.0 Quick Run Workflow Without Sample Information Quick MAN0025835
OpenArray™ AccufFill™ Software v2.0 Full Run Workflow Quick Reference MANO0025836

Download TPF files

The TPF files are downloaded directly from thermofisher.com/OA-platefiles based on an order.

The computer with the OpenArray™ AccuFill™ Software v2.0 must be connected to the internet.

1. In the TPF/SPF screen, select the Download radio button.

2. Select the product.

* TrueMark OpenArray Custom
¢ TrueMark OpenArray Inventoried
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Download TPF files

3. Enter the following information.

Product Information
guehlark a. Enter the Lot number or Batch number.
enArra
P v b. Enter one Serial number from the lot.

Custom
Note: Only one serial number is required. The serial number is used to confirm the
lot number or batch number. All of the files in the lot or batch are downloaded.

TrueMark Enter the list of Serial numbers or Barcodes. Separate more than one serial

OpenArray number or barcode with a comma or a line break.

Inventoried

Note: The serial number or barcode entered corresponds to the file that is
downloaded. Enter a serial number or barcode for each file to download.

Note: The fields that are displayed depend on the product selected in step 2.

4. (Custom Gene Expression plates only) Select one of the following options:

¢ With microbial target names
* Without microbial target names

Note: The microbial target name selection is not displayed if inventoried products are selected.

5. Click Download.

The location of the files is displayed at the top of the screen. The location of the downloaded files

is set in the Preferences menu, in the OpenArray plate file folder field. See QuantStudio™ 12K Flex
OpenArray™ AccufFill™ System User Guide (Pub. No. MAN0025669) for more information about setting
the preferences.

The files are in a compressed ZIP folder.

8 @ B B wm o %A @
Preferences service Help

Deck QuickRun  Full Run MapPlates  TPF/SPF  Folders

© Download successfully saved to D:\OpenArray\OpenArrayPlates\2577466.zip Open folder X

Click Open folder to access the files or click X (Close) to close the message.

Extract the files from the compressed ZIP folder.
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Set up the PCR reactions in an OpenArray™ 384-well
Sample Plate (OpenArray™ AccuFill™ Software v2.0)

IMPORTANT! The 4 x 12 area(s) of the OpenArray™ 384-well Sample Plate being filled must match the
area(s) designated in the OpenArray™ AccuFill™ Software for that set of samples.

1. Remove an OpenArray™ plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. Gently swirl the contents of the TagMan™ OpenArray™ Real-Time PCR Master Mix to thoroughly
mix. Do not vortex the bottle.

3. Following the designated sample plate layout, add master mix, then DNA samples, to the wells of
an OpenArray™ 384-well Sample Plate.
(Optional) Use the TrueMark™ Respiratory Tract Microbiota Amplification Control in place of diluted
preamplified sample, as a positive amplification control sample.

Component Volume per well Volume per sample
TagMan™ OpenArray™ Real-Time PCR Master Mix 2.5uL 5.0 uL
Diluted preamplified sample 25 L 5.0uL
Total reaction volume 5.0 yL 10.0 pL

Note: An overage is recommended when preparing the components.

4. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function
on a multi-channel pipette. Alternatively, vortex the OpenArray™ 384-well Sample Plate for 10-15
seconds after sealing with aluminum foil in step 5.

5. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

6. Centrifuge the plate at 1,200 x g for 1 minute.

7. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.

If you make a sample layout error, it is possible to correct this in the OpenArray™ AccuFill™ Software
using the plate rotation feature. For more information, see QuantStudio™ 12K Flex OpenArray™ AccufFill™
System User Guide (Pub. No. MAN0025669).
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Before you begin—full run workflow

Before you begin—full run workflow

Prepare samples in an OpenArray™ 384-well plate (see “Set up the PCR reactions in an OpenArray™
384-well Sample Plate (OpenArray™ AccuFill™ Software v2.0)” on page 34).

Place the sample plate in the sample plate holder on the AccuFill™ instrument deck, with the notch
to the left.

Do not stack sample plates.

Load the tip boxes, then remove the tip box covers.
Do not stack the tip boxes.

Place the OpenArray™ Plates in the plate holders.
Clear the instrument deck, empty and replace the waste bin, then close the instrument door.
Allow the instrument to perform a self-test if the run is being started after the software is launched.

Prepare the QuantStudio™ 12K Flex OpenArray™ Accessories Kit materials prior to uncovering tip
boxes and removing OpenArray™ plates from packaging.

These materials are used to seal the OpenArray™ Plates.

IMPORTANT! OpenArray™ Plates must be sealed immediately after loading.

Configure the experiment design for the full run workflow

A TPF file is required for this workflow.

Navigate to the Full Run screen.

1.

2.

In the Configure design pane, in the Experiment type section, select Gene expression.

In the Plate format section, select a format.
The values in the Plate format section depend on the experiment type that was selected in step 1.

If the Pipettor section is displayed, select a type of pipette.

* Fixed
¢ Adjustable

In the Add your OpenArray Plate serial numbers section, click Choose File, navigate to the
location of the TPF file, then select the file.

Repeat for each TPF file.

In the Add your sample plates - optional section, click Choose File, navigate to the location of
the CSV file, then select the file.

The format of the sample plate file is validated. For information about the required format, see the
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide (Pub. No. MAN0025669).

The name of the file is displayed in the Select file field.
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Add or edit sample names

6. Repeat step 5 for each CSV file.

7. Click Next.

The Map plates pane is displayed.

Proceed to “Add or edit sample names” on page 36.

Add or edit sample names

If needed, navigate to the Map plates pane in the Full Run screen.

If a sample plate file was imported, the sample names are displayed. The sample plate layout defined in
the sample plate file can be edited.

If the sample plate file was not imported, the samples must be added manually.

1. Add or edit the sample name.
2. Click Next.

Proceed to “Verify the run setup and start the run” on page 36.

Verify the run setup and start the run

1. Click each tip box section so that the status on the Verify and start run pane matches the
physical tip box in the instrument.

We recommend starting the run with full tip boxes. The instrument does not start the run if there
are not enough tips on the deck.

Update the state of the tip boxes
(1) Section of the tip box that is full.

@ Section of the tip box that is empty.

2. (Optional) Click Auto-fill tip boxes.
The status of all sections of the tips boxes is set to full.

3. Select the first section of the sample plate to be used to fill the OpenArray™ Plate.

Select the first section of the sample plate if multiple plates are filled during a run. The software
selects the total number of sections that correspond with the total number of plates.
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Verify the run setup and start the run =~

In the following example, section 5 was selected. The group of sections 5, 6, 7, and 8 is highlighted

by the software because four plates are being filled.
The position box displays the color that corresponds to the section of the sample plate.

Select the sample platelarea to begin

1

w

ENEEEEEEEEER ;

Oianrray plate name and position

@ Sample plate section (section 5, 6, 7, and 8 are highlighted).

@ Corresponding plates.

4. Remove the foil from the appropriate sections of the sample plate, then click the checkbox to

confirm.

Remove the foil only from the sections of the sample plate that are used to load a single

OpenArray™ Plate.

Note: Do not remove the foil from all the sections of the sample plate at once.

5. Close the instrument door.

6. Click Start Run.
The run does not begin under any of these conditions.

The waste bin is not in position.

The sample plate is not in position.

The plates are not in position.

There are more plates on the instrument deck than are defined in the experiment setup.

The Deck screen is displayed.

For a description of the run progress, see QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User

Guide (Pub. No. MAN0025669).

IMPORTANT! Each OpenArray™ Plate must be prepared for PCR immediately after it is filled (see
“Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument” on page 38).
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oM Remove the OpenArray™ Plate from the OpenArray™ AccufFill™ Instrument

Remove the OpenArray™ Plate from the OpenArray™
AccuFill™ Instrument

After an OpenArray™ Plate is filled, the Remove plate and foil dialog box is displayed (see Figure 1).

Remove plate & foil X
Step 1 Step 2
Remove OpenArray Plate 1 and promptly seal the plate Confirm foil is removed from highlighted plate

with the adhesive lid, and fill with immersion fluid.

-]
3
3

=l |

]
N
sy}
~
2]

Figure 1 Remove plate and foil dialog box.

@ OpenArray™ Plate to remove from the instrument.
@ Confirm foil is removed from highlighted plate section checkbox.

Remove each OpenArray™ Plate immediately after it has been filled, even if the run was set up to fill
multiple plates.

After the last OpenArray™ Plate in the run is filled, the Remove plate dialog box is displayed (see
Figure 2).
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Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument

Remove plate X

Remove OpenArray Plate 2 and promptly seal the plate with
the adhesive lid, and fill with immersion fluid.

Figure 2 Remove plate dialog box

@ OpenArray™ Plate to remove from the instrument

1. Open the instrument door and remove the OpenArray™ Plate that is indicated by the blue box in
the dialog box.

IMPORTANT! Remove the OpenArray™ Plate immediately, to avoid evaporation within the plate.

One of the following dialog boxes is displayed:
* The Remove plate and foil dialog box.
* The Remove plate dialog box (after the last OpenArray™ Plate is filled).

2. Seal the case and fill the OpenArray™ Plate with immersion fluid.
See “Seal the OpenArray™ Plate” on page 41.

3. (For Remove plate and foil dialog box only) Remove the foil seal from the next section of the
sample plate, then select the checkbox to confirm that the foil is removed from the section of the
plate that is highlighted.

Note: Remove the foil only from the next section of the sample plate. Do not remove the foil from
all sections of the sample plate.

4. Close the instrument door.
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Remove the OpenArray™ Plate from the OpenArray™ AccuFill™ Instrument

5. Click Done.
The run does not proceed under any of the following conditions:
* The waste bin is not in position
* The sample plate is not in position
* The plates are not in position

* There are more plates on the instrument deck than are defined in the experiment setup
The instrument proceeds to load the next OpenArray™ Plate.
6. Repeat step 1 to step 5 for each OpenArray™ Plate to be loaded.
After all of the plates have been loaded, the Deck screen displays Run completed successfully.
Empty the waste bin before performing another run.

A loaded TPF is generated for each OpenArray™ Plate. The loaded TPF file corresponds to the original
TPF file that was imported for the run. The files are exported to the folder that was designed in the
Preferences.

Note: Some workflows might not generate a loaded TPF file. For more information about the workflows
available for the OpenArray™ AccuFill™ Software v2.0, see QuantStudio™ 12K Flex OpenArray™
AccufFill™ System User Guide (Pub. No. MAN0025669).
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Seal and run the OpenArray™ Plates

Seal the OpenArray™ Plate

IMPORTANT! Throughout this procedure, handle the OpenArray™ Plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray™ Plate and the OpenArray™ Lid.

1. Place the newly loaded OpenArray™ Plate in the QuantStudio™ 12K Flex OpenArray™ Plate
Press 2.0.

Ensure that the barcode is facing left and the serial number is facing right.

2. From the OpenArray™ Lid, remove the clear protective film from the inside of the lid @D and the red
adhesive-protective strip @ from around the edge of the lid.

Figure 3 OpenArray™ Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)
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Seal the OpenArray™ Plate

3. Place the lid in the Plate Press using the alignment pins of the Plate Press for orientation.

IMPORTANT! The notched end of the case lid must be oriented towards the furthest back
right-side of the Plate Press.

@ OpenArray™ case lid
(@ Notched end of lid
@ Serial number of plate
@ OpenArray™ Plate

@ Barcode of plate

(® Alignment pins

4. Seat the lid on the OpenArray™ Plate with the lid adhesive against the plate.

5. Engage the press mechanism until the green flashing light changes to a steady green light (after
20 seconds).

The status light turns solid green, indicating that the case is sealed.

Note: Do not apply additional pressure onto the Plate Press during its actuation.

6. Disengage the press and carefully remove the OpenArray™ Case.

7. Prepare the immersion fluid. Remove the cap, insert the accompanying syringe tip, and prime the
syringe by ejecting a small amount of immersion fluid onto a paper towel to ensure no air gap
remains in the newly attached pipette tip.

IMPORTANT! If the syringe is not primed, the direct burst of air and fluid can negatively affect the
assay(s) at the end of the array.
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Seal the OpenArray™ Plate

O

8. While holding the case upright by its edges at a 15-30 degree angle so that the port is at the
highest point of the array, insert the prepared syringe tip into the port in the case.

The syringe tip must be in front of the array when filling the case with immersion fluid.

9. Slowly inject the OpenArray™ Immersion Fluid until the case is filled, which should take about 10
seconds to fill. Minimize the creation of additional air bubbles when you dispense the fluid. Leave a
small air bubble as shown below.

IMPORTANT! If injected too quickly, the fluid can flush out the samples that are suspended in the
through-holes.

Overfilling the array and/or not leaving a small bubble may cause a leak during the PCR run.
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Chapter 6 Seal and run the OpenArray™ Plates
Run the OpenArray™ Plate on the QuantStudio™ 12K Flex Instrument

10.

11.

While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

Note: Ensure that you are screwing the plug in at the same angle the case base is at. If it is off, it
can cause the plug to break off prematurely.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly to avoid cross-threading.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step. Do
not overtighten. If plastic or adhesive remains attached to the screw due to premature breakout of
the plug handle, remove it with forceps prior to loading it into the instrument.

If needed, clean the case with the lint-free cloth included with the OpenArray™ Plate or a laboratory
wipe that has been thoroughly sprayed with ethanol, then dry the case with a clean laboratory
wipe.

Run the OpenArray™ Plate on the QuantStudio™ 12K Flex
Instrument

44

You can run up to four OpenArray™ Plates at one time on the QuantStudio™ 12K Flex Instrument.

1.

On the QuantStudio™ 12K Flex Instrument touchscreen, touch [ to extend the instrument tray
arm.

Remove the clear protective film from the outside of the OpenArray™ case (sealed plate + lid).

Place the OpenArray™ case on the tray arm plate adapter.

* Support the case from underneath the tray arm to prevent the case from slipping through the
adapter.

¢ Ensure that the plate barcode and serial number are facing the front of the instrument.
Touch [ to retract the instrument tray arm.
In the ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Run pane, click OpenArray.
In the Select Instrument pane, select your instrument.

Click Get Plate IDs to import the barcode of the OpenArray™ Plate.

Once the OpenArray™ serial number appears, the loaded TPF file corresponding to the plate
should appear in the Setup File field.

If the TPF file does not appear, click Browse, then select the correct loaded TPF file from the
Loaded TPF folder.

(Optional) Click Browse to change the Experiment File Location.

(Optional) Change the software-determined Experiment File Name.
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11.

12.

Chapter 6 Seal and run the OpenArray™ Plates 288
Check the quality—control images

Click Start Run.

Note: The instrument pauses at 41 or 42 seconds prior to the end of the run. Wait for the system
to complete the run before opening the EDS file.

Transfer the EDS file from the instrument to an accessible location for analysis.

Check the QC images for loading issues or leaks.

Check the quality-control images

Check the quality—control (QC) images before analysis. Images can be viewed using Imaged, an
open-source software available from the NIH at imagej.nih.gov/ig. For additional information, see
Appendix A, “Troubleshooting”.

1.

In the QuantStudio™ 12K Flex Software E Export screen, click Browse, then create a uniquely-
named folder for the QC images export.

IMPORTANT! Create a new folder for images each time. Exporting a second run to the same
folder overwrites the images.

Click Export QC Images at the bottom of the screen.

View the following ROX™ image to check for loading quality issues:
¢ POST-READ_CHANNEL 4 tiff

Check the following spotfinding images for leaks or other displaced sample issues.
* s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiff
* s02_c040_t03_p0001_m1_x2_el1_cp#_spotfind.tiff

Note: The “cp#” in the image file name refers to array positions 1 through 4 within the instrument.

If a problem is found, view the following pre-run spotfinding image to determine whether the issue
existed before cycling:

* s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiff

View the following FAM™ images to check for fluorescent abnormalities and to confirm any
problem seen in the spotfinding images:

* STAGE2_CYCLE1_CHANNEL_1.tiff
e STAGE2_CYCLE40_CHANNEL_1.tiff

Note any abnormalities found, as well as all other potentially relevant information related to the
setup of the run.
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Analyze data

Select analysis software

Analysis option

Software
Ch QC metrics

Relative Quantification Application [l (recommended)!'! v v

Access the application at thermofisher.com/connect.

QuantStudio™ 12K Flex Software v v

' To perform data analysis using the application, you must export your data. For detailed instructions about exporting data, see

“Export data (if necessary)” on page 46.

Export data (if necessary)

Export your data to review it using the pivot table feature of a spreadsheet program.

1.

2.

3.

4.

46

Open an EDS file in the QuantStudio™ 12K Flex Software.

In the Experiment Menu pane, click $ Export.

Click Load Export Set (bottom of the screen), select GE_export_setting, then click OK.
Select .xIsx from the File Type dropdown list (top-right of the screen).

(Optional) Perform any of the following actions to customize the file export.

* (Click Browse to select a new Export File Location.
* Enter a new file name in the Export File Name text field.

* C(Click the Results tab, then select the content to export.

Click Start Export (bottom of the screen).

If Open file(s) when export is complete is selected, then the file automatically opens. If the option
is not selected, navigate to and open the exported XLSX file.
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Chapter 7 Analyze data 3%
Review results

Review results

Note: These guidelines apply to results from experiments that included three or more technical
replicates.

1.

In the analysis settings of the software, choose the relative C,; method.

The relative C,; method is recommended for dried-down assays. Dried-down assays can
reconstitute at different rates, causing a dip in the early cycles of the baseline. C,; can correct
for a variable baseline.

* In Relative Quantification Application [§:
a. Click £+ (Analysis Settings).
b. Inthe C, Settings tab, select Use Cy.
c. Click Finish.

* |n QuantStudio™ 12K Flex Software— select Analysis Settings » Ct Settings » Algorithm
Settings » Relative Threshold.

Review amplification curves (in log or linear view), Cy values, and amplification curve QC metrics
(Amp Score and Cq Confidence) for each reaction.

QC metric Description

Amp Score A value to indicate the quality of the amplification curve.

Cq Confidence A value to reflect the reliability of the derived Cg.

(Optional) Filter data in the order indicated in the following table.

Note: We encourage testing and establishing your own C,; cut-off value and amplification curve
QC metrics for each assay to achieve high sensitivity and specificity.

Parameter to examine | Consider filtering out sample data using the following cut-off values

Crt Crt > 28

Amp Score Amp Score < 1.2
The following assays have a cut-off value of < 1.1

* RNase P (RPPH1)

* Human Enterovirus (EV_pan)

Cq Confidence Cq Conf< 0.7

Note: The following assays have a cut-off value of < 0.5
. RNase P (RPPH1)

. Bordetella holmesii (B. holmesii)
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Considerations for data analysis

Note:

. We encourage testing and establishing your own C; cut-off value for each assay to achieve high
sensitivity and specificity.

. Through-holes with unexpected Cy values can also be identified by reviewing the Amplification
Plot (see “Troubleshoot unexpected Crt values” on page 51).

4. Note replicates with mean C < 25 and a standard deviation > 0.5. The data from these through-
holes might require further review.

5. Ensure that at least half of the replicates amplified adequately and pass your review specifications.

6. Use your preferred method to analyze the data.

Considerations for data analysis

48

Organisms that are covered by more than one assay

For full strain coverage of adenoviruses or rhinoviruses, two assays are used. A positive result with
either or both of the assays indicates a positive result for the organism.

Species-specific assays that are also covered by pan or broad coverage assays

Species-specific
assay

Considerations for data analysis

Flu A assays

The Flu_A_pan assay detects Influenza A H1 and H3, for which there are also
strain-specific assays.

Samples that are positive for the Flu_A_H1 or Flu_A_H3 assay typically are positive
for the Flu_A_pan assay.

Bordetella assays

The Bordetella assay detects B. pertussis, B. bronchiseptica, and B. parapertussis
strains. Strain-specific assays for B. pertussis and B. holmesii are also available.

Most samples that are positive for the B. pertussis assay are also positive with the
Bordetella assay.

RSV assays

Samples that are positive for the RSVA assay may be detected at a lower efficiency
(a difference of several C; values) by the RSVB assay.

Enterovirus (EV)
and rhinovirus
(RV) assays

The RV assays detect both RV and EV strains whereas the EV assays are specific
for EV strains. Thus, enterovirus positive samples are detected by both EV and RV
assays whereas rhinovirus positive samples are detected only by the RV assays.

The EV_pan assay detects all human enterovirus species except D68, for which
there is a strain-specific EV_D68 assay.

Samples that are positive for the EV_D68 assay may be detected at a lower
efficiency (a difference of several C; values) by the EV_pan assay.
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Chapter 7 Analyze data B30

Approximate Crt range for controls

Species-specific
assay

Considerations for data analysis

HHV assays

* |tis not unusual to detect M. catarrhalis, H. influenzae, K. pneumoniae, S.
pneumoniae, and S. aureus in respiratory samples as these are commensal or
Bacterial and transiently commensal upper respiratory tract microbes.

* Due to the high prevalence of human infection with HHV4 (EBV) and HHV® viruses,
these viruses can be detected at low levels in some respiratory samples.

Approximate C, range for controls

If used as recommended in this guide, the approximate C, range for control assays are as follows.

Control Approximate C,; range
TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno) Control 18-20
TrueMark™ Universal Extraction Control Organism (B. atrophaeus) 21-23
TrueMark™ Respiratory Tract Microbiota Amplification Control 18-21

Fields for reviewing results with pivot tables

To review results using the pivot table feature of a spreadsheet program, you can use the following

settings.

Note: For the "Average of" and "StdDev of" summarizations, use the appropriate source field (C;, Amp
Score, or C, Conf), then choose the calculation type.

Area of pivot table

Fields to add

Target-oriented view

Sample-oriented view

Filters — Sample Namel'!
Columns Sample Name —

Rows Target Name Target Name
Values Average of C Average of C

StdDev of G

StdDev of C[?

Count of Cy

Count of Cy
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Chapter 7 Analyze data
Fields for reviewing results with pivot tables

(continued)

Fields to add

Area of pivot table
Target-oriented view

Sample-oriented view

Values —

Average of Amp Score

Average of Cy Conf

' To see individual sample results, select the sample from the dropdown list next to the Sample Name header.

@ A Values field will automatically appear in the Column Labels area.

TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments User Guide




Troubleshooting

Troubleshooting: Nucleic Acid Isolation

Observation Possible cause Recommended action
Beads remain in sample after | Excessive amount of recovered host Increase elution volume to 100 pL.
elution genomic DNA/RNA is preventing Reduce the input volume of starting

nucleic acid separation from the beads. sample to 200 pL.

Reduced extraction Proteinase K enzyme was either Always add Proteinase K enzyme to the
efficiency of TrueMark™ omitted from the sample or added sample separately and before adding the
Universal RNA Spike incorrectly. Binding/Bead Master mix.

In/Reverse Transcription

(Xeno) Control TrueMark™ Universal RNA Spike Ensure that the TrueMark™ Universal
In/Reverse Transcription (Xeno) Control | RNA Spike In/Reverse Transcription
added at the wrong step. (Xeno) Control is added to the

Binding/Bead Master mix before
dispensing into sample wells.

Troubleshoot unexpected C,; values

Observation Possible cause Recommended action
Unexpected Cy; values in the amplification plot Unexpectedly low C,; values | Review amplification curves,
(<10) — Signal variation or Amp Score, and Cq
noise in early PCR cycles Confidence values.
—® Consider filtering C,; values

from analysis.

Compare replicates, if

__@ available.

Dilute the samples, then
repeat the experiment.

Unexpectedly high Cy Review amplification curves,
values (25-28) — Sporadic Amp Score, and Cgq
S amplification Confidence values.

Compare replicates, if

@ Expected C,; value (noted in most replicates) .
available.

@ Unexpected C,; value (too low)

Repeat the experiment.
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Appendix A Troubleshooting
Troubleshoot with cycling and imaging run images (QC images)

Troubleshoot with cycling and imaging run images (QC
images)
Many problems with OpenArray™ results can be diagnosed by examining the quality control (QC)
images taken at various points during a cycling/imaging run.

The QC images are fluorescent or reflected light images taken before, during, and after cycling. They
may require adjustment to make image features visible. To view the images, we recommend that you
install the free software program Imaged, which allows you to easily manipulate the images in ways that
other image viewers cannot.

1. In the QuantStudio™ 12K Flex Software Export screen 5
a. Click Browse to select a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Select a new folder for images each time; exporting a second run to the same
folder overwrites the images.

2. Use ImagedJ to view the images of interest.

To...

View image...

Image description

Confirm the identity of
images within a folder

BARCODE IMAGE.tiff

Reflected light image of the
entire OpenArray™ Plate.

Evaluate the loading quality

PRE-READ_CHANNEL_4.tiff
POST-READ_CHANNEL_4.tiff

Pre- and post-ROX™ dye
images.

Check for existing
contamination on the case
and/or heated cover

s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiffl!]

Pre-run reflected light
spotfinding image (used by
the software to determine the
location of the holes).

Identify potential leaks or
other contamination

s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiffl!]

Mid-run reflected light
spotfinding image.

s02_c040_t03_p0001_m1_x2_e1_cp#_spotfind.tiffl!]

Post-run reflected light
spotfinding image.

Look at patterns in
the fluorescent data (for
example, gradients)

STAGEx_CYCLEy_CHANNEL_1.tiff

FAM™ images at a particular
cycle (y) of a particular stage (x)
of the run.

1 The “cp#” in the image file name refers to the array position (1-4) within the QuantStudio™ 12K Flex Real-Time PCR Instrument.

3. (Optional) Adjust the images for brightness and/or contrast to make image features visible.

a. Open the image in ImageJ.

b. Select Image » Adjust Brightness/Contrast (or press Ctrl+Shift+C).

c. Click Auto or adjust the sliders until the features of interest in the image are visible.
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Appendix A Troubleshooting

OpenArray™ AccuFill™ Instrument plate loading errors

OpenArray™ AccuFill™ Instrument plate loading errors

Observation

Possible cause

Recommended action

There are empty through-holes

Insufficient sample was
added to the 384-well
Sample Plate.

Use proper pipetting
techniques. Ensure that there
are no air bubbles in the
pipette tips after sample
aspiration.

Reaction mix (sample +
master mix) is not at the
bottom of the 384-well
Sample Plate.

Centrifuge the plate at
1,200 x g for 60 seconds.

Turn-holes are repeatedly missed

The OpenArray™ AccuFill™
Instrument is aligned too far
to the left or to the right.

Systematic loading problems
can occur with the
OpenArray™ AccuFill™
Instrument, which indicates
a need for service. For
example, when turn-holes
are repeatedly missed across
multiple subarrays, service

is required. Turn-holes

are where the instrument
changes direction during
sample loading.

06500650
OO OO OO0
OO OO0 OO0
OO OO OO0
OO OO OO0
OO OO OO0
@@ OO OO0
Q006000

@ Turn holes
© Start points
@ Stop points

Contact your local field
service engineer.

Entire subarrays are missing

The sample/master mix was
not added to particular wells
in the 384-well Sample Plate.

Visually inspect the plate to
ensure that the wells have
sample/master mix.

Stuck tip mandrel on

the OpenArray™ AccuFill™
Instrument may need
cleaning.

Contact your local field
service engineer.
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Appendix A Troubleshooting
OpenArray™ Plate assembly and handling errors

Observation

Possible cause

Recommended action

Entire subarrays are missing

(continued)

Pipette tip was not loaded on
mandrel.

Contact your local field
service engineer for frequent
occurrences (infrequent
occurrences can be due to a
poorly molded tip).

OpenArray™ Plate assembly and handling errors

Observation

Possible cause

Recommended action

Case leaks and bubbles inside the case

Improper sealing of the OpenArray™ Plate in the
OpenArray™ Case can lead to immersion fluid
leaks or bubble formation inside the case, leading
to uneven heating and imaging throughout PCR
and to poor quality data.

The images above are examples of OpenArray™
Plates that have been affected by immersion fluid
leaks. The images show where leaked fluid has
condensed on the underside of the heated cover

Plate press was not engaged
for at least 20 seconds.

Fully engage the plate press
for at least 20 seconds.

Damaged lid adhesive.

Remove the liner and visually
inspect the lid adhesives for
defects. Ensure that adhesive
is not damaged or warped.

Damaged fill port screw
gasket.

Visually inspect the screw to
ensure that the orange gasket
is present and not damaged.

Damaged fill port screw
assembly. Breaks off too
easily.

The screw may be mis-
threaded: unscrew it and use
a new screw assembly.

Oily lid or case from
immersion fluid overflow.

Wipe off excess overflow

of immersion fluid from

the lid, case bottom, and
crevices with 70% isopropyl
alcohol, using a lint-free
cloth (the cloth included
with the OpenArray™ Plate is
acceptable).

Immersion fluid was exposed
to air for too long.

Do not remove the immersion
fluid syringe cap or draw air
bubbles into the syringe until
you are ready to load.
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Appendix A Troubleshooting

OpenArray™ Plate assembly and handling errors

Observation

Possible cause

Recommended action

windows and obscured the view of the through-
holes.

The best image in which to detect leaks is the
s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiff
image. This image is taken at the start of

cycling, which is where most leaks occur. See
“Troubleshoot with cycling and imaging run
images (QC images)” on page 52.

Too large of a bubble inside
the OpenArray™ Case after
sealing.

Minimize the size of the
bubble by tilting the
OpenArray™ Case so that the
fill port is at the highest

point. Slowly fill the case

with immersion fluid until only
a small air bubble remains.
Attach the screw and wipe off
any excess oil that may have
spilled onto the case.

Damaged plate press, leading
to uneven pressure.

Contact your field service
engineer if you suspect that
your plate press may be
damaged.

Sample blow-out during the addition of immersion
fluid

The reactions in A12 were
compromised during the
addition of immersion fluid.
Injecting the immersion fluid
too quickly can purge the
sample out of the through-
holes near the fill port. Often
this is caused by the user not
purging the syringe slightly
before use.

Dispense a small amount
of immersion fluid onto a
paper towel before use to
ensure smooth operation of
the syringe.

Evaporation of reaction mixture in through-holes

Too much time elapsed
before the plate was sealed
with lid and immersion fluid.
In this example, the top

half of each subarray was
intentionally left open to the
environment to demonstrate
the effect of evaporation.
“Donuts” are a result of

the evaporated fluid in the
though-holes.

Add immersion fluid as soon
as the case is removed from
the plate press to minimize
the likelihood of evaporation,
then seal the case with the
lid.

TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments User Guide

55




Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Appendix B Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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Appendix B Safety
Biological hazard safety

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-
P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document Publication Number

Isolation of Nucleic Acid for Respiratory Tract Microbiota Profiling Experiments Quick MANO0018526
Reference

TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments using MANO0018529
OpenArray™ AccufFill™ Software v1.2 Quick Reference

TrueMark™ OpenArray™ Plates for Respiratory Tract Microbiota Profiling Experiments using MANO0025991
OpenArray™ AccuFill™ Software v2.0 Quick Reference

TrueMark™ OpenArray™ Respiratory Tract Microbiota Plate Product Information Sheet MANOO018631
TrueMark™ Respiratory Tract Microbiota Amplification Control Product Information Sheet MANO0018533
TrueMark™ Universal Extraction Control Organism (B. atrophaeus) Product Information Sheet MANOO018535
TrueMark™ Universal RNA Spike In/Reverse Transcription (Xeno) Control Product Information MANO0018534
Sheet

QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
QuantStudio™ 12K Flex Real-Time PCR System v1.4 Maintenance and Administration Guide 4470689
Thermo Scientific™ KingFisher™ Flex User Manual MANO0019870
OpenArray™ Sample Tracker Software Quick Reference, for OpenArray™ AccuFill™ Software 4460657
v1.2

OpenArray™ AccufFill™ System User Guide, for OpenArray™ AccuFill™ Software v1.2 4456986
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System User Guide, for OpenArray™ AccuFill™ MANO0025669
Software v2.0

TagPath™ 1-Step RT-qPCR Master Mix, CG User Guide MANO0007959
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Appendix C Documentation and support
Symbols that may be displayed on the instrument, in the software, or in this guide

Symbols that may be displayed on the instrument, in the
software, or in this guide

Symbol Description Symbol Description
™ MANUFACTURER ] DATE OF MANUFACTURE
CATALOG NUMBER [sN] SERIAL NUMBER
E| CONSULT INSTRUCTIONS FOR USEL A CAUTIONI!

' Appendix C, “Documentation and support”

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
- Product FAQs

— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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